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1.0. Preface 
The CV-2100 Companion PC Ethernet Interface Software User’s Guide is not intended to replace 
the CV-2100 User’s Manual.  This guide assumes the user is familiar with the basic setup and 
operation of the CV-2100. 
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2.0. Overview of the CV-2100 Companion PC Ethernet Interface 

2.1. About The CV-2100 Companion 
 
The CV-2100 Companion PC Ethernet Interface is a Windows-based software program that 
connects to your Keyence CV-2100 High Speed Digital Machine Vision System to a PC through 
a TCP interface on your LAN (local area network). 
 
The CV-2100 Companion features support for the following functionality: 
 

• Remote Console/Display  providing you a graphical interface to remotely control your 
CV from your PC 

• CV data and imaging acquisition capabilities to log your CV measurements and part 
images 

• Live data acquisition display window to display your measurement data and part images 
during your manufacturing run 

• Remote Terminal Interface to provide you with the means to remotely interface with your 
CV via a Telnet-style interface. 

• Run-time modification of limits and tolerances for any window 
• COMM mode function interface to support: 

o Changing the current program 
o Changing the current window number  
o Saving/writing program data from/to the CV 
o Saving/writing environmental settings from/to the CV 
o Saving/writing image data from/to the CV 
o Image registration 
o Saving/writing registered images from/to the CV 
o Clearing the image buffer 
o CV screen captures 
o CV date/time setup 

2.2. Minimum System Requirements 
• Microsoft Windows 95, 98, Me, NT (SP4), 2000, and Windows XP 1 
• 256MB RAM 
• Ethernet interface 
• Screen resolution of 800 x 600 using Small Fonts 
• MDAC (Microsoft Data Access Components 2.8 or greater) – available from CV-2100 

Companion Setup Utility. 
• Microsoft Jet 4.0 database engine – available from the CV-2100 Companion Setup 

Utility. 
 
1  Windows XP is recommended.  Support for Windows 95, 98, Me, and NT is limited. 
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3.0. Getting Started 

3.1. Installing the CV-2100 Companion Ethernet Interface Software 
There are two methods of installing the CV-2100 Companion Software.  The recommended 
method of installation.makes use of  the CV-2100 Companion Setup Utility available from 
Conquest Consulting LLC (www.conquestsolutions.com).  The CV-2100 Companion Setup 
Utility automatically detects the versions of MDAC and Jet installed on your PC and allows the 
user to install them prior to installing the CV-2100 Companion. 
 
The second method requires that the user has already installed Microsoft Data Access 
Components (MDAC) version 2.8 or greater and the Microsoft Jet 4.0 database engine.  These 
components are available from the Microsoft Web site (www.microsoft.com).  After these 
components have been installed, you may install the CV-2100 Companion PC Ethernet Interface. 

3.1.1. Using the CV-2100 Companion Setup Utility  
The CV-2100 Companion Setup Utility can be downloaded from www.conquestsolutions.com.  
Once downloaded, unzip the file and run SETUP.EXE.  You will be presented with a screen 
similar to the following: 
 

 
 
To properly install the CV-2100 Companion, follow steps 1 -3: 
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Step 1 – Install MDAC 2.8 
The CV-2100 Companion Setup Utility will show you the version of MDAC currently installed 
on your system.  It will also instruct you whether or not you need to install MDAC 2.8. 
 
If you are instructed to install MDAC 2.8, then install it by clicking on Click here to install 
MDAC 2.8.  Follow the screen instructions to install MDAC. 
 
NOTE: If the set up utility finds MDAC 2.8 on your system, you can still re-install it to be sure 
MDAC is properly installed. 
 

_______________________________________________________ 
 
Step 2 – Install Microsoft Jet 4.0 Database Engine 
The CV-2100 Companion Setup Utility will inform you if Jet 4.0 has been found in your registry.  
It will also show you the operating system it has detected.  The setup utility will instruct you 
whether to install the Jet 4.0 database engine or not.  If you are instructed to install Jet, click Click 
here to install Jet 4.0 Engine.  
 
NOTE 1: If the operating system displayed is NOT the operating system that you are using, do 
not install Jet 4.0 from the setup utility.  Download and install the appropriate version of Jet 4.0 
from the Microsoft Web site (www.microsoft.com). 
 
NOTE 2: If you are told that you do not need to install Jet 4.0, you may wish to install it anyway 
to be sure it is properly installed. 
 

_______________________________________________________ 
 
Step 3 – Install the CV-2100 Companion PC Ethernet Interface 
After you have properly installed MDAC and Jet 4.0, if required, install the CV-2100 Companion 
Software by clicking on Click here to install the Companion.  This will install a 30-day trial 
version on your PC. 
 
 
After installation, you will be able to run the CV-2100 Companion by selecting from the 
Programs list under your Start Menu or from the icon on your desktop. 
 

3.1.2. Installing the CV-2100 Software after Manually Installing MDAC and Jet 4.0 
Download the CV-2100 Companion PC Ethernet Interface from www.conquestsolutions.com and 
unzip it.  Run SETUP.EXE and follow the instructions to install the software.  This will install a 
30-day trial version on your PC. 
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3.2. Connecting Your CV-2100 
You can communicate with your CV using the CV-2100 Companion software.  You may connect 
your PC and the CV-2100 by: 
 

1. directly connecting your PC to the CV-2100 without going through a local 
area network (LAN) .  Use the OP-42275 cross cable available from 
Keyence. 

2. connecting both your CV-2100 and your PC to a local area network (LAN).  
Please consult with the systems administrator or network administrator 
during this process to ensure proper setup. 

 
 
To change or view the Ethernet settings from the CV-2100, select Environmental Settings from 
the Setup Menu: 
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Select Ethernet from the Environmental Settings Menu: 
 

 
 
You will be able to change or view the Ethernet IP address and/or port from here: 
 

 
 
 
For more information on connecting your CV-2100 via Ethernet, reference your CV-2100 User’ s 
Manual. 
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3.3. Running the CV-2100 Companion Ethernet Interface Software the First 
Time 
The CV-2100 Companion will detect the first time you are running the software on a machine and 
present you with a form similar to this: 
 

 
 
This form will allow you to specify the IP address and port number the CV has been set to in the 
previous step.  If you need to change these settings again in the future, you will be able to under 
the Options-Settings menu. 
 
Once you have properly specified the remote host IP and port number, press the Continue button.  
The software will attempt to connect to your CV-2100.  While the CV-2100 Companion tries to 
connect to the CV-2100, the user will see the following message box: 
 

 
 
If the CV is unable to connect, you will be presented with the prompt shown to the right.  
Possible connection problems are: 
 

• Incorrect Ethernet settings in the CV or the CV-2100 
Companion 

• A bad or unplugged Ethernet cable 
• Another device is currently communicating with the CV-

2100 
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If the CV-2100 Companion properly connects to your CV, it will be indicated in the title bar of 
the application. 
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4.0. Using the CV-2100 Companion PC Ethernet Interface 
The CV-2100 Companion supports a diverse set of features to enhance the functionality of your 
CV-2100. Your CV-2100 operates in different modes (RUN, TRIAL, PROGRAM, COMM) .  
Not all features are available in all modes. 
 
This section outlines each of these features and which modes they are available in. 
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4.1. Resetting Your CV-2100 
Menu Location:  File > Reset 
Supported in Modes:  RUN, TRIAL, COMM 
 
This feature will reset the CV data counters and current measurements.  The CV will be placed in 
a mode as if power was cycled. 
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4.2. Data Acquisition with the CV-2100 Companion PC Ethernet Interface 
The CV-2100 is capable of transmitting part data and images on each trigger via the Ethernet 
connection. 
 
One of the most useful features of the CV-2100 Companion is the capability of logging this 
measurement and image data from your CV-2100 to an Access database file.  When the CV-2100 
Companion is in data acquisition mode, most other features are disabled to ensure your data is 
reliably received. 

4.2.1. Data Acquisition Setup 
Setting up your CV to perform data acquisition is easy.  The basic steps are: 
 

1. Setup the CV-2100 to output data/images via the Ethernet connection. 
2. Use the CV-2100’ s data acquisition setup wizard to detect the CV-2100’ s acquisition 

settings and create the data acquisition file. 
3. Start data acquisition mode. 

 
Reference the CV-2100 User’ s Manual to setup the CV to output data and images via the Ethernet 
connection. 
 
To setup the CV-2100 Companion for data acquisition, follow these steps: 
 

1. Select Create New Acquisition File from the Data Acquisition menu.  This will start the 
data acquisition wizard.  Follow the instructions provided on the first screen of the wizard 
and click Next. 
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2. The next form in the wizard displays the output format of the data that the CV will 
transmit on subsequent triggers with the current configuration.  After you have verified 
the settings, click the Next button to continue.  
 
IMPORTANT NOTE: The data acquisition file and settings you are creating will only 
be valid for this output format.  If you make any changes to the CV-2100 that modifies 
this output format, you will need to create a new data acquisition file. 
 

 
 
3. The next form in the wizard displays the trigger options available. 

 

 
 
External Trigger: Select this option if the CV-2100 will be externally triggered OR if 
you will use the CV-2100’ s internal trigger feature. 
 
PC Trigger - Manual: Select this option if the operator of the CV-2100 Companion 
software will use the manual trigger button in the program to prompt a trigger. 
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External Trigger: Select this option if the CV-2100 Companion should trigger the CV 
on a periodic basis automatically.  After selecting this option, set the appropriate time 
base in the ‘Automatic Trigger Settings’  box. 

 
4. The last form in the wizard requires a name for the Access database file and allows the 

user to specify what type of measurement and image data will be displayed/saved during 
data acquisition mode. 
 

 
 
Access data acquisition file: Name given to the Access database and the settings files.  
 
NOTE: Database files are found in the database directory.  The database directory is 
located in the same folder where the software was installed. 
 
Data Display/Save Options: 
         Save all incoming measurement data and images to database: (Checked by default)  
                                         - Unchecking this option will suppress saving any measurement 
                                            data and images to the disk (database). 
          No data displayed: No data will be displayed during data acquisition mode. 
          Display all captured data: All data from the CV will be displayed to the user. 
          Display only failures: Only failed part data is displayed to the user. 
 
          NOTE:  Regardless of the Data Display Options all data collected from the CV 
                        will be saved to the Access database file. 
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5. Display part images when received by CV: 
          The CV can be configured to send part image data on each trigger or when a part 
           has been given a ‘NG’  judgment.  When checked, the CV will look for these part  
           images to be sent from the CV and will display them to the user in a window. 
 
           NOTE: Regardless of the status of this option, all part image data sent from the  
                        CV will be saved to disk and a pointer to the image will be inserted in 
                        the database associated with the corresponding measurement data. 
 
Save Screen Capture on Failure: 
          Although the CV-2100 can be configured to send failed part image data, the sent  
          images lack the measurement information that is displayed on the CV. 
          In the instances where the user requires this information on the image, this option 
          will request a screen capture from the CV whenever a failed part is detected.  This 
          image will be saved to disk and a pointer to the image will be inserted in the  
          database to associate it to the correct part data.  This option should only be used 
          when the time between triggers exceeds 20 seconds. 
 
           NOTE: When using this option, be sure to configure the CV so that NO part image  
                        data is sent. 
 
Display Screen Capture on Failure: 
         When saving screen captures on part failures, the user can use this option to display 
          the screen capture to the user when it is received.  This option should only be used 
          when the time between triggers exceeds 20 seconds. 
 
           NOTE: When using this option, be sure to configure the CV so that NO part image  
                        data is sent. 

 
6. After you press the Finish button, data acquisition mode must be stared before data is 

logged.  The software will prompt for data acquisition mode to be started after the wizard 
has completed.  If it is not started at that time, it can be started (and stopped) at any time 
from the Data Acquisition Menu. 
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4.2.2. Using the CV-2100 Companion PC Ethernet Interface in Data Acquisition Mode 

4.2.2.1. Manual Trigger 
Menu Location:  Data Acquisition > Manual Trigger Button 
Supported in Modes:  RUN, TRIAL 
 
Allows the user to manually trigger the CV. 
 
When selected, a form with a Trigger button is displayed.  Each time the button is pressed a 
trigger command is sent to the CV. 
 

 
 

4.2.2.2. Modifying the Data Acquisition Settings 
Menu Location:  Data Acquisition > Options 
 
Using the Options menu, the user can modify most of the data acquisition settings that were 
established in the final form of the data acquisition wizard (with the exception of trigger options). 
 

 
 



Copyright © 2004, Conquest Consulting LLC. 
All rights reserved. 

 

16 

4.2.2.3. Data Acquisition Display Panel 
If the current display options specify that measurement data is to be displayed to the operator 
during data acquisition mode, it will be displayed in the Data Acquisition Display Panel.  The 
panel will automatically become visible as soon as the first part measurements are sent from the 
CV-2100. 
 

  
 
The Data Acquisition Display Panel is broken into four main sections. 
 

Data History: This section is used to display the most recent raw data collected from the 
CV.  This screen will automatically clear itself on a periodic so the buffer is not overrun. 
 
Last Data Sample Received: This section is used to display the raw data for the last 
sample obtained from the CV along with its judgment (PASS/FAIL). 
 
Counters: Display the number of parts that have passed and failed along with the total 
count. 
 
Display Panel Controls: When enabled, this section can be used to pause the display of 
incoming data so the current data set can be looked through by the operator.  NOTE: 
Pausing the display does NOT pause incoming data from the CV from being stored in the 
database.  This will continue in the background. 
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4.3. Change Binary Limits 
Menu Location:  Limits/Tolerances > Modify Binary Data Limits 
Supported in Modes:  RUN, TRIAL, COMM 
 
This feature will allow you to view and change the binary limits for any valid window set up in 
the CV-2100. 
 
When selected, the following form is displayed: 
 

 
 
 
Either: 
 

1. Select a valid Window from the drop-down list and click OK or 
2. Click the View ALL Valid Windows button 

 
 
Clicking the View ALL Valid Windows button will expand the form and display all of the valid 
Windows with limits that can be modified.  Select a valid window and click OK: 
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After selecting a valid window, you will be shown the current limits.  From here you may change 
any of the limits and click OK to change the limits (NOTE: valid limits: 000 – 255). 
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4.4. Modifying Tolerance Settings 
Menu Location:  Limits/Tolerances > Modify Tolerance Settings 
Supported in Modes:  RUN, TRIAL, COMM 
 
This feature will allow you to view and alter the tolerance settings for a valid window or a 
measured value calculated window. 
 
When selected, the following form is displayed: 
 

 
 
First, select a valid measurement window (W01 – W64) or a valid measured value calculated 
window (C01-C32). 
 
If a standard measurement window is selected, the user must also select a valid window 
measurement type and a tolerance type.  Valid measurement types are: 
 

• Area Measurement 
• Pattern Position Measurement 
• Pattern Mutli-Position Measurement 
• Edge Position Measurement 
• Edge Gap Measurement 
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• Edge Pitch Measurement 
• No. Edges Measurement 
• Stain Measurement 
• Blob Measurement 
• Trend Edge Position Measurement 
• Trend Edge Gap Measurement 
• Intensity Measurement 

 
Valid tolerance settings are based on the measurement type selected.  They are as follows: 
 

• For Area Measurement 
o Area 

• For Pattern Position Measurement 
o X Pos 
o Y Pos 
o Angle 
o Corr. 

• For Pattern Mutli-Position Measurement 
o Quantity 
o X Pos 
o Y Pos 
o Angle 
o Corr. 

• For Edge Position Measurement 
o When measurement area is Rectangle 

� No. Edges 
� X Pos 
� Y Pos 

o When measurement area is Rectangle/Rot. Rect 
� No. Edges 
� Position 

o When measurement area is Ring/Arc 
� No. Edges 
� Gap 

• For Edge Gap Measurement 
o When measurement area is Rectangle/Rot. Rect 

� No. Edges 
� Gap 

o When measurement area is Ring/Arc 
� No. Edges 
� Angle Gap 

• For Edge Pitch Measurement 
o When measurement area is Rectangle 

� No. Pitches 
� Max Gap 
� Min Gap 

o When measurement area is Ring/Arc 
� No. Pitches 
� Max Angle Gap 
� Min Angle Gap 
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• For No. Edges Measurement 
o No. Edges 

• For Stain Measurement 
o Number of Stains 

• For Blob Measurement 
o No. Blobs 
o Area 
o Cent Grav. X 
o Cent Grav. Y 
o F. Dia. X 
o F. Dia. Y 
o Angle 
o Perimeter 
o Roundness 

• For Trend Edge Position Measurement 
o When measurement area is Rectangle 

� No. Edges - Max 
� No. Edges - Min 
� No. Edges - Average 
� Max Pos 
� Min Pos 

o When measurement area is Rot. Rect 
� No. Edges 
� Max Pos 
� Min Pos 

o When measurement area is Ring/Arc 
� No. Edges 
� Max Rad Gap 
� Min Rad Gap 

• For Trend Edge Gap Measurement 
o When measurement area is Rectangle/Rot. Rect 

� No. Edges 
� Max Gap 
� Min Gap 

o When measurement area is Ring/Arc 
� No. Edges 
� Max Rad Gap 
� Min Rad Gap 

• For Intensity Measurement 
o Avg. Intensity 
o Intensity Dev. 
o Max Intensity 
o Min Intensity 

 
NOTE: If a measured value calculated window is selected, measurement type and tolerance type 
selections do not apply and will be disabled. 
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To view the current tolerance, be sure you specify to look at the upper or lower tolerance and 
click the Read Current Tolerance button. 
 
To modify the tolerance, enter the new tolerance value in the appropriate location and click the 
Set New Tolerance button.  The new tolerance value will be verified for proper format before 
being sent to the CV-2100. 
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4.5. COMM Mode Commands 

4.5.1. Enter COMM Mode 
Menu Location:  COMM Mode > Enter COMM Mode (from RUN mode) 
Supported in Modes:  RUN 
 
Before any “COMM-mode” commands can be executed, the CV-2100 must be placed in COMM 
mode. 
 
You must be in RUN mode to enter COMM mode. 
 

4.5.2. Exit COMM Mode 
Menu Location:  COMM Mode > Exit COMM Mode (to RUN mode) 
Supported in Modes:  COMM 
 
Use this feature to exit COMM mode.  The CV-2100 will be returned to RUN mode. 
 
You must be in COMM mode to execute this command successfully. 
 

4.5.3. Change Current Program Number 
Menu Location:  COMM Mode > Change Current Program 
Supported in Modes:  COMM 
 
The CV supports up to 32 different programs (00 - 31).  Through COMM mode, the user can 
change the current program. 
 
 

 
 

 
Select a new program number from the list and click Change. 
 
You must be in COMM mode to execute this command successfully. 
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4.5.4. Change Current Window Number 
Menu Location:  COMM Mode > Change Current Window Number 
Supported in Modes:  COMM 
 
The CV supports up to 64 different windows (01 - 64).  Through COMM mode, the user can 
change the active window. 
 
 

 
 

Select a new window number from the list and click Change. 
 
You must be in COMM mode to execute this command successfully. 
 

4.5.5. Save Program Data from CV 
Menu Location:  COMM Mode > Save Program Data From CV 
Supported in Modes:  COMM 
 
It is important to backup your programs from the CV-2100 in the event they are modified or 
erased.  Saving your programs will also allow users to copy programs to other CV-2100’ s. 
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Select either the current program that is active or select a program number from the drop down 
list.  Once the program data has been read from the CV, the user will be prompted for a file name 
to save the program to. 
 
You must be in COMM mode to execute this command successfully. 
 
NOTE: The CV does not distinguish between program slots that have been configured and ones 
that have not been configured.  The program will successfully back-up an un-configured slot, but 
when the program is written back to a CV, it will fail the CV’ s checksum check and the user will 
be presented with an error. 
 

4.5.6. Write Program Data to CV 
Menu Location:  COMM Mode > Write Program To CV 
Supported in Modes:  COMM 
 
After saving a program from the CV, a user can write that program back to the CV. 
 

 
 

After selecting this menu option, the user will be prompted for the file to load and then will be 
shown the form above.  Select either the current program that is active or select a program 
number from the drop down list to write the program data to. 
 
You must be in COMM mode to execute this command successfully. 
 
NOTE: The CV does not distinguish between program slots that have been configured and ones 
that have not been configured.  The program will successfully back-up an un-configured slot, but 
when the program is written back to a CV, it will fail the CV’ s checksum check and the user will 
be presented with an error. 
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4.5.7. Saving Environmental Settings from the CV 
 
Menu Location:  COMM Mode > Save Environmental Setting From CV 
Supported in Modes:  COMM 
 
Saves the CV’ s environmental settings data to disk.  Selecting this menu option will prompt the 
user to enter the file name to save the environmental settings to. 
 
You must be in COMM mode to execute this command successfully. 
 

4.5.8. Writing Environmental Settings to the CV 
 
Menu Location:  COMM Mode > Write Environmental Setting To CV 
Supported in Modes:  COMM 
 
Writes environmental settings from disk to the CV.   The user will be prompted for the file 
containing the saved environmental settings. 
 
You must be in COMM mode to execute this command successfully. 
 

4.5.9. Get/Save Image Data from the CV 
 
Menu Location:  COMM Mode > Get/Save Image Data From CV 
Supported in Modes:  COMM 
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Allows the user to retrieve and save the last image taken to disk.  Specify the camera number, 
whether or not Split Capture is being used, and click the Get Image button.  The image will be 
loaded from the CV and displayed to the user as shown below: 
 

 
 
From this screen, the user may save the image to a BMP file by clicking the Save Image To File 
link. 
 
You must be in COMM mode to execute this command successfully. 
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4.5.10. Write Saved Image Data to the CV Image Buffer 
 
Menu Location:  COMM Mode > Write Saved Image Data To CV Image Buffer 
Supported in Modes:  COMM 
 
Allows the user to save a previously saved image to the CV-2100 image buffer.  Prompts the user 
to select an image from disk that will be written to the CV image buffer.  After an image is 
selected, user is prompted with the following form: 
 

 
 

 
Specify the camera number to assign the image to.  If using the split capture function of the CV-
2100, check this option and the appropriate trigger. 
 
The advanced options allow the user to select whether this image is to be added as a new image 
into the image buffer or if it is to overwrite the last image that was stored in the buffer.  The 
default is to add this image as a new image. 
 
You must be in COMM mode to execute this command successfully. 
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4.5.11. Image Registration 
Menu Location:  COMM Mode > Image Registration 
Supported in Modes:  COMM 
 
Forces the last image stored in the CV-2100’ s image buffer to become the registered image. 
 

 
 

Select the appropriate camera to register and if the split capture function is being used, check this 
option and select the correct trigger. 
 
You must be in COMM mode to execute this command successfully. 
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4.5.12. Get/Save Registered Image from the CV 
 
Menu Location:  COMM Mode > Get/Save Registered Image From CV 
Supported in Modes:  COMM 
 

 
 
Allows the user to retrieve and save the registered image for the selected camera and program 
number.  The image is retrieved from the CV when the Get Image button is clicked.  It will be 
displayed to the user as follows: 
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From this screen, the user may save the image to a BMP file by clicking the Save Image To File 
link. 
 
You must be in COMM mode to execute this command successfully. 
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4.5.13. Write Registered Image To CV 
 
Menu Location:  COMM Mode > Write Registered Image Data To CV 
Supported in Modes:  COMM 
 
Writes a previously saved image into the CV as the registered image for the selected camera and 
program number.  Prompts the user to select an image from disk that will be written to the CV 
image buffer.  After an image is selected, user is prompted with the following form: 
 

 
 

 
Specify the camera number and the appropriate program number.  If using the split capture 
function of the CV-2100, check this option and the appropriate trigger. 
 
You must be in COMM mode to execute this command successfully. 
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4.5.14. Clear Image Buffer 
 
Menu Location:  COMM Mode > Clear Image Buffer 
Supported in Modes:  COMM 
 
Clears the CV-2100’ s image buffer. 
 

4.5.15. Screen Capture (via Remote Console/Display) 
 
Menu Location:  COMM Mode > Screen Capture (via Remote Console) 
Supported in Modes:  RUN, TRIAL, PROGRAM, COMM 
 
Retrieves a BMP image of the CV-2100’ s current screen.  This function uses the Remote 
Console/Display window.  Please refer to the Remote Console/Display section for more 
information on this feature. 
 

4.5.16. Set Date/Time 
 
Menu Location:  COMM Mode > Set Date/Time 
Supported in Modes:  COMM 
 
Allows the user to set the date/time in the CV-2100. 
 

 
 
The current date/time of the CV will be displayed at the top of this form.  The calendar and the 
time control will be initialized to the PC’ s current date/time. 
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To set the date, select the month and year from the drop-down lists.  Select the day of the month 
by clicking on the day in the calendar. 
 
To set the time: set the hours, minutes, and seconds separately by selecting the “Set Hour”, “Set 
Minutes”, or “Set Seconds” respectively.  Use the up/down arrows to increase or decrease the 
settings. 
 
Click the Update Time button to update the CV-2100’ s current date/time. 
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4.6. Options 
The options menu allows the user to set options and preferences related to the operation of the 
CV-2100 Companion. 

4.6.1. Connection Options 
Menu Location:  Options > Settings > Connection Tab 
Supported in Modes:  N/A 
 

 
 

 
Remote Host (IP): The IP address of the CV-2100. 

Remote Port: The port number of the CV-2100. 
Timeout: The number of seconds the CV-2100 Companion will wait 

for requests to the CV to be completed. 
 
 



Copyright © 2004, Conquest Consulting LLC. 
All rights reserved. 

 

36 

4.6.2. Remote Console Options 
Menu Location:  Options > Settings > Remote Console Tab 
Supported in Modes:  N/A 
 

 
 
The Remote Console/Display window has an option on the display window marked as Auto-
update.  When this option is selected a screen capture is requested from the CV to update the 
Remote Console/Display window’ s display each time the pseudo-remote console is used to send 
a command to the CV-2100.  Due to limitations in the CV-2100, there are certain situations where 
the CV will send a screen capture before the CV is done updating the screen.  This will cause the 
screen image viewed from the CV-2100 Companion to be different than the actual screen of the 
CV. 
 
Although, this situation is not common and not serious, to assure the CV-2100 Companion’ s 
screen image matches the CV’ s, a time delay can be used to wait for the CV to complete screen 
updates so the CV-2100 Companion will accurately portrait the image on the CV. 
 
Testing performed by Conquest Consulting has shown that 5 seconds appears to be an adequate 
time delay to resolve this issue.  This setting can change based on specific network conditions.  
Therefore, the user is allowed to change this delay from 0 to 10 seconds.  The software is shipped 
using a delay of 0 seconds, however the Default button will set the delay to 5 seconds. 
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4.7. Windows 
The Windows menu contains interactive windows used to remotely control the CV-2100. 
 

4.7.1. Remote Console/Display 
Menu Location:  Windows > Remote Console/Display 
Supported in Modes:  ALL 

 

 
 

The Remote Console/Display window allows the user a graphical remote interface to the CV-
2100.  The left hand area of this window is used to display a BMP image representing the current 
CV-2100 display.  The right hand area of this window contains a pseudo-remote console (A.K.A. 
pendent) along with some options and command links. 
 
The image can be updated in two ways.  The first is to click the Update Display link.  The 
second is to select the Auto-update option.  When using the Auto-update option, the display 
will be updated each time the pseudo-remote control is used to send a command to the CV. 
 
The pseudo-remote console operates the same as the actual remote control and is operated by 
clicking with the mouse over each button or arrow (arrows are used to simulate the movement of 
the joystick).  For more information on the operation of the remote console, please refer to the 
CV-2100 User’ s Manual. 
 
To save the BMP image currently displayed by the Remote Console/Display, click the Save 
Image To File link.  The user will be prompted to select a file name to save the image. 
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NOTE: When using the Auto-update option, a screen capture is requested from the CV to update 
the Remote Console/Display window’ s each time the pseudo-remote console is used to send a 
command to the CV-2100.  Due to limitations in the CV, there are certain situations where the 
CV will send a screen capture before the CV is done updating the screen.  This will cause the 
screen image viewed from the CV-2100 Companion to be different than the actual screen of the 
CV.  To resolve this, increase the delay time in under the Options > Settings > Remote Console 
menu. 
 

4.7.2. Remote Terminal Interface 
Menu Location:  Windows/Remote Terminal Interface 
Supported in Modes:  ALL 

 

 
 
The Remote Terminal Interface provides a text-based interface for users to control the CV-2100 
by manually entering CV commands.  The communications history window shows a history of 
communication to and from the CV. 
 
To send a command enter it in the text box at the top and click the Send button or hit the Enter 
key on the keyboard. 
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5.0. Registering the CV-2100 Companion Ethernet Interface 
When installed on a new computer, the CV-2100 Companion runs on a free 30 day trial license.  
The software is fully functional during this period.  After the 30 day trial period has expired, the 
software will no longer function until it is registered. 
 
Registering the software will provide the user with a license to allow the software to run on the 
PC it is installed with no time limitations.  The license that is used by the software is specific to 
the computer it is running on.  It is generated from the serial numbers of specific hardware 
components installed on this PC, thus rendering it useless on any other computer.  If the user 
wishes to install and use the software on another computer, the license can be transferred from 
one computer to another using a floppy disk. 

5.1. How to Register the CV-2100 Companion 
If the CV-2100 Companion is not registered, each time the software is run, the following 
registration form will be displayed (NOTE: This form can be also displayed by selecting 
File/Register This Copy of the CV-2100 Companion.): 
 

 
 
This form provides the user with instructions on registering this copy of the CV-2100 
Companion.  To register, follow the instructions shown on the form.  (NOTE: As part of the 
registration process, the software’ s trial mode will end.  Therefore, be sure you are ready to 
register the software when starting the process.) 
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The registration process is as follows: 
 

1. End trial mode by clicking the ‘Register Now’  link found at the bottom of the form.  You 
will be asked to confirm you wish to start the registration process. 
 

2. Record the SERIALIZATION NUMBER that you are provided with.  This number is 
created from the serial numbers of specific hardware on this PC. 
 

 
 

3. Visit the Conquest Consulting (Keyence solutions division) Web site at  
                                                    
                                                     www.conquestsolutions.com 
 
Click on the appropriate link to register your software and follow the instructions to 
purchase a license.  Once you have purchased your license, you will be able to enter the 
SERIALIZATION NUMBER for your software and obtain the ACTIVATION CODE. 
 

4. Enter this ACTIVATION code in the registration form and click the Enter Activation 
Code button. 
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5.2. How to Transfer the CV-2100 License to another Computer 
Once a copy of the CV-2100 has been registered, the license can be transferred from one 
computer to another.  To transfer the license, select File > Transfer Software License To Another 
Computer: 
 
This form provides the user with instructions on transferring the license from the original 
computer to the new one. 
 
The details of this process are as follows: 
 

1. Install the CV-2100 Companion PC Ethernet Interface on the NEW computer and run it 
in trial mode. 

2. If not already displayed on the new computer, display the Registration Form by selecting 
the File/Register This Copy of the CV-2100 Companion menu option: 
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3. Click on the Register Now link.  The user will be warned that the registration process 
will end trial mode.  Accept the warning.  The activation form will be displayed: 
 

 
 

4. Prepare a floppy disk for the license transfer by clicking on the Prepare Transfer button.  
The user will be prompted to insert a floppy disk into the disk drive. 
 

 
 
Place a blank floppy disk into the drive of the NEW PC and click OK.  Wait a few 
seconds for the disk to be written to.  The user will be s a message box indicating the disk 
is prepared: 
 

 
 
 

5. Click OK and remove the floppy disk from the drive.  Place the floppy disk in the 
ORIGINAL computer and run the CV-2100 Companion (currently still licensed).  Select 
File/Transfer Software License To Another Computer: 
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6. Click the Transfer License Now link.  Click Yes when asked, “ Are you sure you wish to 

transfer your license to another PC?”   The user will be prompted to insert the floppy disk 
(the prepared transfer disk should be in the computer at this point): 
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7. Click the OK button.  Wait a few seconds for the license to be transferred to the floppy 
disk.  When the license has been transferred to the disk, the user will be prompted with 
the following message box: 
 

 
 

8. The software will end because it no longer owns a valid license.  Remove the floppy disk 
and insert it into the NEW computer once again.  If not already displayed on the NEW 
computer, bring up the activation form by running the software: 
 

 
 

9. Click the Transfer License button.  The user will be prompted for the disk containing the 
license (it should be in the floppy disk drive at this point): 
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10. Click OK.  Wait a few seconds for the license to be transferred to the NEW computer.  
After the license has been transferred, the user will be prompted with the following 
message box: 
 

 
 

11. The NEW computer now owns the license to use the CV-2100 Companion software in 
unlimited mode. 
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6.0. Support 
For all support options, please visit www.conquestsolutions.com. 


